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Microsoft Excel Helps You Better Use the Web

Microsoft® Excel 97 offers a host of new capabilities that help people interact with the Internet and the World Wide Web. This paper is written for Web Administrators, IS Managers, Internet and intranet developers, and others who want to improve the content and interactivity of their own web sites for millions of Microsoft Excel users. With its new capabilities, Microsoft Excel 97 lets users tap into the vast resources on the Internet and on private intranets for publishing, gathering, and analyzing information. For example, you can automatically pull daily sales, stock, company financial reports, or other information from your intranet server directly into a worksheet for tracking and analysis. You can create an HTML Web page that gains substantial capabilities when opened in Microsoft Excel, such as PivotTables® and AutoFilter lists.

Much of the information presented to Internet users today is in HTML (HyperText Markup Language) tables. Tables are a useful way to organize information and display it effectively and attractively. With Microsoft Excel 97, you can import HTML, especially tables, directly into Microsoft Excel worksheets.

Web Queries, a new capability in Microsoft Excel 97, go beyond importing HTML by letting you query a specific Web page or server, and receive the result in a Microsoft Excel worksheet. A query can be automatic, can prompt for parameters, or can use the contents of a worksheet as input. Worksheets can use Web Queries to pull live data from the Internet or an intranet, and then perform calculations and analysis on the data. Information can be refreshed automatically and as often as needed while maintaining worksheet layout and formulas, even if the amount of data returned changes.

Microsoft Excel 97 supports hyperlinks which allows users to click on a cell or object and connect to an Internet or intranet Web page, another Microsoft Excel worksheet, or Microsoft Office document. Microsoft Excel also supports several HTML extensions that allow tables to display normally in a browser. These extensions also automatically include formulas, formatting styles, PivotTables, and AutoFilters when imported into Microsoft Excel. Finally, all of these tools can be fully automated using Microsoft Excel Visual Basic for Applications for custom solutions and vertical applications based on Microsoft Excel and Office.

Microsoft Excel 97 is a powerful tool with a variety of Internet and intranet information, including:

· Application front-end

· Catalogs

· Employee and group information

· Financial/management queries

· Performance tracking

· Phone directories

· Policies and procedures

· Price lists

· Product information

· Product support database

· Project information

· Sales updates and tracking

· Stock quotes

Microsoft Excel 97 supports multiple levels of Internet and intranet integration. You can open pages directly from the Web or save a worksheet as an HTML document. Or, by creating worksheets or Visual Basic applications to take full advantage of new features, you can achieve customized solutions tailored for your specific needs. In short, virtually any information that can be presented in HTML tables can be enhanced through Microsoft Excel. You can go beyond browsing to manipulating, managing, and analyzing Internet or intranet data using the tools with which you and over 30 million others are already familiar—those in Microsoft Excel.

What This Connectivity Kit Contains

The following sections of the Microsoft Excel Web Connectivity Kit explain how particular enhancements to Microsoft Excel can help you improve the experience users have on your Web site in conjunction with Microsoft Excel 97. Each section begins with a brief overview of the topic, followed by more details. Browse the overview to determine whether the topic is relevant to your needs, and then read the details for examples, ideas, implementation suggestions, and places to go for further information. There is also an appendix with descriptions of the files accompanying this kit.

Web-related enhancements to Microsoft Excel and discussed in this Kit are:

· Hyperlinks

· Web Query

· HTML support and extensions

This Kit assumes a basic understanding of Microsoft Excel, Web browsers such as Microsoft Internet Explorer, and HTML. If you need additional information about these topics, refer to the appropriate documentation. For other Internet-related information, see the following:

· Microsoft Excel 97 Web Query page at http://www.microsoft.com/excel/webquery/
· Microsoft Internet Center at http://www.microsoft.com/internet/
· Microsoft Site Builder Workshop at http://www.microsoft.com/workshop/
Hyperlinks

Hyperlinks are cells or objects in Microsoft Excel worksheets that a user clicks to connect to another location in the worksheet, another worksheet, or an Internet or intranet URL or other network address and file. Create hyperlinks by selecting the cell or object and clicking Hyperlink on the Insert menu or by using a hyperlink formula in the form =HYPERLINK (link_location, friendly_name).

To create a hyperlink with the Hyperlink command, type an entry in a cell, select the cell, and then click Hyperlink on the Insert menu. If you have not saved your worksheet, you are prompted to do so. At that point, the Insert Hyperlink dialog box is displayed, as shown in Figure 1.
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Figure 1: The Insert Hyperlink dialog box allows you to create links in Microsoft Excel cells to connect to other information.

Enter a file name or URL and a named location in a worksheet, if desired, and click OK. On the worksheet, the link is displayed as underlined, blue text until you click it, at which point it changes to magenta. To modify an existing hyperlink, click the link with the right mouse button, point to Hyperlink, and click Edit.

To create a hyperlink using a formula, type the formula in the following form:

= HYPERLINK("link_location","friendly_name")

where link_location is the file or URL reference, and friendly_name is the text you want to appear in the cell. For example, typing:

= HYPERLINK("http://www.microsoft.com","Microsoft")
creates a hyperlink to Microsoft’s home page, with the word “Microsoft” displayed as blue, underlined text in the cell.

When an HTML document containing hyperlinks is imported into Microsoft Excel 97, the links are maintained and can be used just like the manually created links described previously. For more information about HTML tag support, see “HTML Support and Extensions” later in this kit.

Web Queries

Web Queries allow you to query data from a specific site on the Internet or an intranet server and receive the information directly into Microsoft Excel. Microsoft Excel 97 includes four sample Web Queries, and more are available on the Web Query sample page of the Microsoft Excel Web site (http://www.microsoft.com/excel/webquery/samples.htm). Web Queries can be used in a number of situations that take information from the Internet or an intranet server to Microsoft Excel where it can be stored, manipulated, analyzed, and published. Web Queries give you the ability to make your information available to Microsoft Excel users in a format that takes advantage of Microsoft Excel functionality while still maintaining non-Microsoft Excel HTML capabilities for non-Microsoft Excel users.

To use Web Queries, you need an Internet or intranet connection and all the necessary protocol software running, either through a corporate LAN (local area network) or a dial-up Internet Service Provider.

Like any other data query in Microsoft Excel, a Web Query extracts information from a data store and brings some or all of the data into Microsoft Excel. Web Queries rely on Internet or intranet technology such as HTML forms and CGI (Common Gateway Interface) scripts set up on the server to do the processing while Microsoft Excel receives the results in the form of an HTML document.

Web Queries are text files with the file extension .iqy, and contain three or four lines of text (depending on the type of Web page being queried), separated by carriage returns. For more information about the content of Web Queries, see “Creating a Web Query” later in this kit. Web Queries can be easily created for many sites with little more than the URL.

Running a Web Query

To run a Web Query, point to Get External Data on the Data menu, click Run Web Query, select from the available Web Queries, and then click Get Data. This kit includes sample Web Queries as described in the appendix. 

Note   While these queries worked when this document was published, Microsoft does not guarantee them because these sites are not owned or maintained by Microsoft. Nevertheless, this should be useful for demonstration purposes.

Once you have selected a query (IQY file), you are prompted for the desired location of the results, as shown in Figure 2.
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Figure 2: Microsoft Excel asks you where to place the results of your Web Query.

Select the starting cell or range for your query results, or select the New worksheet option. If the query is static (does not prompt for parameters), it runs, and displays the results in Microsoft Excel. If the query is dynamic (prompts for parameters), Microsoft Excel prompts you with a series of dialog boxes like the one shown in Figure 3.
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Figure 3: The Enter Parameter dialog box allows for dynamic parameters in a Web Query.
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Enter the desired values and click OK. You can use the range selector button at the right of the entry field to select worksheet cells for the parameter values. If you want to specify multiple cells, Microsoft Excel parses the range of cells from left to right and top to bottom to create the string of values to send to the server. Values in the string are separated by the plus sign (+). The results of the query are displayed in your Microsoft Excel worksheet at the location you specify.

Creating a Web Query

A Web Query is a text file with the file extension .iqy. It consists of three or four lines of text separated by carriage returns. Once you run a query in a worksheet and then save the worksheet, you no longer need the IQY file for that worksheet. The query information is saved with the worksheet and can be rerun anytime. IQY files are only used the first time a query is run in a given worksheet to establish the data location and parameters.

Web Queries are in the following syntax:

Type of Query (optional)
Version of Query (optional)
URL (required)
POST Parameters (required for queries referencing POST forms/data)
You can create a Web Query using any text editor, such as Notepad. There are two basic types of queries: static and dynamic. A static query does not prompt the user for information, while a dynamic query prompts the user for values that it uses in the query. For information about static and dynamic queries, see “Static and Dynamic Parameters” later in this document.

Two sample files representing both types of queries are included with this kit: S_Quote.iqy and M_Quotes.iqy. The content of these files is as follows:

S_QUOTE.IQY
WEB[CR]

1[CR]

http://webservices.pcquote.com/cgi-bin/excelget.exe?TICKER=msft

M_QUOTES.IQY
WEB[CR]

1[CR]

http://webservices.pcquote.com/cgi-bin/excel.exe[CR]

QUOTE0=["QUOTE0","Enter up to 20 symbols separated by spaces."]

These examples are derived from two queries that come with Microsoft Excel 97 and can be used on any Web-enabled computer. They use live stock data from PC Quote (http://www.pcquote.com/). The following discussion of each line of a Web Query refers to these two examples.

Type of Query 

The only valid entry for this field in a Web Query is WEB. If this value is omitted, Microsoft Excel assumes WEB. This value is optional unless a version of query is specified. In other words, type of query and version of query must be used together or not at all.

Version of Query 

The only valid entry for this field is 1. This value is optional unless a type of query is specified. If type of query is not specified, then this line should not be included.

URL

This is the file location where the query is sent and is the only required field unless the Web page being queried is a POST type. For information about POST queries, see “POST parameters” later in this document. It takes the form http://server/file; or in the case of a local file, drive:\folder\file; or on a network share, \\server\share\folder\file.

When building a query for an existing Web page, you can often enter data through your browser in the site’s form, then copy the resulting URL from your browser’s address field to this line in the query. Copying the URL also allows you to get data from any page that has data you would like to use in Microsoft Excel. For example, if you want to bring the Bureau of Labor Statistics Economy at a Glance table into Microsoft Excel, enter http://stats.bls.gov/eag.table.html into an IQY file and run the query. You could also open the HTML file with the URL as the file name, but that would bring in the entire page, whereas with a query it brings in only the tabular data from the page.

Copying the URL works for GET HTML forms, where the parameters are appended to the URL, such as http://webservices.pcquote.com/cgi-bin/excelget.exe?TICKER=msft in S_Quotes.iqy. POST HTML forms, as the one discussed in the following section, require the parameters to be sent to the server as a separate line of text after the URL. For GET queries, however, the parameters are included immediately after the URL and a question mark:

http://server/file?parameters
POST Parameters

Using an HTML form, there are two methods of sending parameters to the server: GET and POST. Essentially, GET is used when sending small amounts of information, and POST is for larger amounts of data. The GET method appends the data to the URL, whereas the POST method sends it as a separate line of text. GET is the default method, but because a URL of more than about 200 characters could cause problems, the POST method ensures that a large amount of data is processed correctly. The server application and the creator of the HTML form determine which method to use. In the examples, the S_Quote query uses GET, and the M_Quotes query uses POST. For more information about GET and POST, see “HTML Form Tags and Web Queries” later in this document.

HTML input fields in the <FORM> section of the page determine what parameters to include. POST parameters go in the fourth line of text after the URL in a Web Query:

http://server/file
POST parameters
Static and Dynamic Parameters

In Web Queries, static parameters send query data without prompting the user, while dynamic parameters prompt the user for one or more values, which are used in the query. 

Static queries include the parameter names and the values to be passed to the server. If there are multiple parameters, they are separated by an ampersand (&): 

parameter1=value1&parameter2=value2
Some servers accept multiple values for a single parameter. In such cases, the values within each parameter are separated by a plus sign (+):

parameter1=value1+value2+value3+value4&parameter2=value5+value6
To create a dynamic parameter, replace the values with two arguments in braces. The first argument is the argument name, and the second argument is the text, enclosed in quotation marks, to be displayed in the Microsoft Excel-generated dialog box. Dynamic parameters are in the following format:

parameter1=["value1","Prompt for first  value"]&paramter2=["value2","Prompt for second value"]
The braces in a dynamic query signal Microsoft Excel to build a dialog box when the query is run that prompts the user with text in the second argument. The user’s response becomes the value of the first argument.

For example, the sample S_Quote query is a static query with a single parameter:

WEB

1

http://webservices.pcquote.com/cgi-bin/excelget.exe?TICKER=msft

However, this same query could be written to be dynamic, prompting the user for the company symbol to use:

WEB

1

http://webservices.pcquote.com/cgi-bin/excelget.exe?TICKER=["TICKER","Enter
   your stock symbol for a detailed quote."]

Likewise, the sample M_Quotes query is written as a dynamic query:

http://webservices.pcquote.com/cgi-bin/Microsoft Excel.exe

QUOTE0=["QUOTE0","Enter up to 20 symbols separated by spaces."]

However, it could be a static query:

http://webservices.pcquote.com/cgi-bin/excel.exe

QUOTE0=msft+ibm+novl+nscp+cosff+gm+f+t+pcqt
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As a static query, M_Quotes.iqy returns stock quotes for the companies listed, while as a dynamic query, M_Quotes.iqy prompts the user with a dialog box like that shown in Figure 4:
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Figure 4: Example of a dialog box created on the fly by Microsoft Excel during a dynamic query.

Web Query Properties
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When you run a Web Query, you can set properties for the query by clicking Properties in the Returning External Data to Microsoft Excel dialog box shown in Figure 2. The dialog box for setting Web Query properties is the same as the dialog box you use to set options for any data query in Microsoft Excel. However, certain check boxes, such as Save password or Include field names, are not available since they do not apply to Web Query.

Figure 5: External Data Range Properties dialog box for a query.

* If there are no HTML tables in the query results, the entire page will be imported.

Web Query Parameters 

If the query includes dynamic parameters, you can change various settings for them by clicking Parameters on the Returning External Data to Microsoft Excel dialog box shown in Figure 2. Parameters you set for your dynamic query do not affect the IQY file, but are saved in the worksheet from which the query is run. The Web Query Parameters dialog box is shown in Figure 6.


Figure 6: The Web Query Parameters dialog helps you set options with dynamic parameters. 

Using the Web Query Parameters dialog box, you can manage the parameters and prompts for your query within the worksheet. You can prompt for a value, have the query use a specific value, or use a value from a cell reference. You cannot use the Web Query Parameters dialog box, however, to add new values or make changes to the IQY file.

HTML Form Tags and Web Queries

To create a Web Query, you need to know what information the Web server is expecting and the URL where that HTML form information is to be sent. Often the only way to get this information is to study the HTML tags on the Web page you are querying. While it is beyond the scope of this kit to explain all HTML tags, this section does provide some guidelines to help you create a successful Web Query with Microsoft Excel 97.

You can view the HTML tags for any Web page in your browser (for example, in Microsoft Internet Explorer, click Source on the View menu). 

GET Form Example

The following example from the sample file StockGet.htm demonstrates the most important GET form tags for a Web Query:

<HTML>

<HEAD>

<TITLE>Stocks, Inc. Get form</title>

</head>

<BODY bgcolor=#FFFFFF>

<CENTER>

<H1>Stocks, Inc.</h1>

Get one detailed stock quote. Type in the company symbol you wish to use:

<BR>

<FORM method="GET" action="/cgi-bin/client.exe">

<INPUT NAME="quote">

<BR>

<BR>

<INPUT TYPE="submit" VALUE="Get quote">

<INPUT TYPE="reset" VALUE="Clear value">

</form>

</center>

</body>

</html>

In a browser, the form created by the preceding example looks like the illustration in Figure 7.

Figure 7: Sample Web form page with a single stock quote input (StockGet.htm).

You can use the following information from the HTML tags in this example when building a Web Query for this form:

The FORM method is GET, so the IQY file should have three lines of text, and any parameters go on the same line as the URL.

The ACTION argument within the FORM tag shows the destination URL for the query. This is the address the server uses to generate the final Web page with the data. Sometimes the full URL is listed here and sometimes only a relative path, as in this example. If a relative path is listed, precede it in the IQY file with the location of the form page. So, if http://www.stocksinc.com is the location of this imaginary Web page, the full Web Query URL would be:

http://www.stocksinc.com/cgi-bin/client.exe

For a GET form, the simplest way to get the URL for the query is to fill in the form in your browser and then copy the resulting URL from the browser’s address field into your IQY file. The resulting URL includes the full path and the parameters used, which you can substitute in the query with other parameters or dynamic prompts. Sometimes this approach does not work due to hidden fields, and you may have to examine the HTML tags to troubleshoot your results.

The INPUT NAME="quote" tag shows the name the server is using for the parameter. You must use this same name in the query so the server recognizes the value Microsoft Excel sends.

Since this example is a GET form, a static Web Query to get stock information for Microsoft (msft) would be:

WEB

1

http://www.stocksinc.com/cgi-bin/client.exe?quote=msft

To make this query prompt for a stock symbol, substitute “msft” with a dynamic parameter:

WEB

1

http://www.stocksinc.com/cgi-bin/client.exe?quote=["stock","Enter the desired company
   symbol:"]

In Microsoft Excel, the result of this Web Query looks like the illustration in Figure 8.

Figure 8: Sample results in Microsoft Excel of a GET query for a single stock quote (SResults.htm).

POST Form Example

The following example from the sample file StockPst.htm demonstrates the most important POST form tags for a Web Query:

<HTML>

<HEAD>

<TITLE>Stocks, Inc. Post form</title>

</head>

<BODY bgcolor=#FFFFFF>

<CENTER>

<H1>Stocks, Inc.</h1>

Get four up-to-date stock quotes. Type in the company symbols you wish to use:

<BR>

<FORM method="POST" action="/cgi-bin/client.exe">

<INPUT NAME="quote1">

<INPUT NAME="quote2">

<INPUT NAME="quote3">

<INPUT NAME="quote4">

<BR>

<BR>

<INPUT TYPE="submit" VALUE="Get quotes">

<INPUT TYPE="reset" VALUE="Clear values">

</form>

</center>

</body>

</html>

In a browser, the form created by the preceding example looks like the illustration in Figure 9.

Figure 9: Sample Web form page with a multiple stock quote input (StockPst.htm).

You can use the following information from the HTML tags in this example when building a Web Query for this form:

The FORM method is POST, so the IQY file should include a fourth line that contains the parameters.

The ACTION argument within the FORM tag shows the destination URL for the query. This is the address the server uses to generate the final Web page with the data. Sometimes the full URL is listed here and sometimes only a relative path, as in this example. If a relative path is listed, precede it in the IQY file with the location of the form page. If http://www.stocksinc.com/ is the location of this imaginary Web page, the full Web Query URL would be:

http://www.stocksinc.com/cgi-bin/client.exe

As stated above, often the simplest way to get the URL for the query is to fill in the form in your browser and then copy the resulting URL from the browser’s address field into your IQY file. However, in the case of a POST form, the resulting URL includes the full path but not the parameters you used, so you must look at the HTML source to get the correct parameter names. In POST forms, there are sometimes static or hidden parameters that the Web Query must send, but which are not displayed in the browser. To find such parameters, check carefully for all NAME= values in the HTML tags, and include all necessary values in the query.

The four INPUT NAME="quotex" tags show the names the server is using for the parameters. You must use these same names in the query so the server recognizes the values Microsoft Excel sends.

Since this example is a POST form, the static Web Query to get stock information for Microsoft (msft), IBM (ibm), General Motors (gm), and Intel® (intc) would be:

WEB

1

http://www.stocksinc.com/cgi-bin/client.exe

quote1=msft&quote2=ibm&quote3=gm&quote4=intc

To make this query prompt for stock symbols, substitute “msft,” “ibm,” “gm,” and “intc” with dynamic parameters (note that the fourth line of the query is one line with no carriage returns, even though it is too long to display as one line of text here):

WEB

1

http://www.stocksinc.com/cgi-bin/client.exe

quote1=["stock1","First company symbol"]&quote2=["stock2","Second company 
   symbol"]&quote3=["stock3","Third company symbol"]&quote4=["stock4","Fourth 
   company symbol"]

In Microsoft Excel, the result of this Web Query looks like the illustration in Figure 10.

Figure 10: Sample results in Microsoft Excel of a POST query for multiple stock quotes (MResults.htm).

URL Encoding

In order to send data to a Web server, the text must be URL encoded. That is, all non-URL characters must be stripped out or replaced by other characters that are acceptable in a URL address. Microsoft Excel does this automatically if parameter values are entered through a dialog box. For example, spaces are not supported URL characters, so a plus sign (+) is used between multiple values in a single parameter instead of a space. Microsoft Excel automatically substitutes plus signs for spaces typed in a parameters dialog box—for example, in the multiple stock quote query (M_Quotes.iqy).

If you create a static query that sends values directly to the Web server, you must use URL encoding in the IQY file on both the URL and the Post Parameters lines, according to the following guidelines:

· Leave uppercase and lowercase characters from A to Z, numerals from 0 to 9, dash (-), period (.), and underscore (_) as-is; they are all acceptable URL characters.

· Change spaces to plus signs (+).

· Hex encode all other characters. That is, take the hexadecimal (base 16) value of the ASCII character and precede it with a percentage sign (%).

For example, if you want to include in your query the text string:

Value number42-9 "text"

you must instead include the string:

Value+number42-9+%22text%22

because plus signs replace spaces, and 22 is the hexadecimal value of the ASCII double-quote character.

Much information is published about URL encoding on the Web. Two starting places are http://www.uni-passau.de/~ramsch/iso8859-1.html and http://www.bbsinc.com/iso8859.html.

Getting Dynamic Parameters from a Worksheet

While it’s easy to create a simple Web Query knowing little more than the target URL, fully exploiting the power of Microsoft Excel 97 provides greater ease of use and flexibility for those using the queries. Using other features of Microsoft Excel in conjunction with queries lets you create powerful and attractive worksheets as the interface for your data. Once you create the worksheet, all the query information is contained in the worksheet making it unnecessary to distribute the IQY file.

Figure 11: Sample worksheet (PCQuote.xls) that pulls the parameter value from the spreadsheet.

PCQuote.xls is an example of a worksheet that uses this approach. It was created using the Web Query file PCQuote.iqy. In Microsoft Excel, you enter a company stock symbol in cell C3, press Enter, then click the Update button in cell C5 to refresh the query. The query results come into the Data sheet but are copied into the Results sheet to allow control over formatting. This workbook pulls data from PC Quote’s Web site and gives detailed stock information on a single company. You can try out the Web page used for this query at http://www.pcquote.com/cgi-bin/getquote.exe?. 

Handling Non-Text Variables

Some Web pages include ways to input data other than text fields, such as radio buttons, check boxes, and drop-down lists. These methods of input are not currently supported in a standard Web Query. However, there are two ways to handle this type of information:

· Create the query using static information for the variables. By studying the HTML source, you can tell what the names and values should be, and you can put that data into the query. You can prompt the user for these parameters, but because exact values must often be sent to the server, it may result in a failed query.

· Build a dialog box using form tools or Visual Basic in Microsoft Excel. You can then store the values in cells or Visual Basic variables and send the information to the query. This allows you to duplicate all the information from the form in an attractive interface in the Microsoft Excel worksheet, then capture the user input and send it to the Web page.

For more information about Web form input, see your favorite HTML educational Web page, or try http://www.microsoft.com/workshop/. For information about using Visual Basic with Microsoft Excel, see Microsoft Excel online Help.

HTML Support and Extensions

Microsoft Excel 97 offers good support for HTML table and general formatting tags, but limited or no import of other tags, such as forms and graphics. Microsoft Excel also supports four table tag extensions that let you create HTML tables which appear correctly in a browser. When brought into Microsoft Excel, these tables are enhanced with supporting features such as formatting, formulas, PivotTables, and AutoFilter lists.

The following sections list some of the most important HTML tags and how they are converted in Microsoft Excel. The section “HTML Extensions in Microsoft Excel 97” includes descriptions of the four HTML tag extensions supported by Microsoft Excel. These sections assume an understanding of HTML and do not attempt to document what the tags do when read in a browser, only how they are handled when imported into Microsoft Excel. For more information about HTML, see the Microsoft Site Builder Workshop at http://www.microsoft.com/workshop/.

General and Structural Elements

Tags that control the general structural elements of a Web page, such as HTML, HEAD, BODY, and BACKGROUND, are ignored. 

The TITLE tag places text in the Title edit box on the Summary tab in Properties dialog box (File menu).

Text

Most tags discussed in this section are in the sample file HTMLTags.htm. Open this file to view the effect of these tags in Microsoft Excel and your browser. The following tags affect text in Microsoft Excel as explained:

BR places the text or item one row down in the worksheet.

P places the text or item two rows down in the worksheet.

LISTING, PRE, PLAINTEXT, TT, and KBD format text as Courier. KBD also formats text as bold.

BLOCKQUOTE treats text as paragraph text, but indentation is set to 4, and the merged cells do not include the rightmost cell in that row.

B and STRONG format text as bold.

I, DFN, CITE, and EM italicize text.

U underlines text.

CODE and SAMP set the font 1 size smaller than default.

VAR formats the text as Courier and sets the font 1 size smaller than default.

ADDRESS is placed in a cell and italicized.

CENTER centers text horizontally.

NOBR places text in a cell with wrapped text turned off.

Anchors

The A tag places a hypertext link in a cell and formats the cell with the hypertext style. 

Both the HREF and NAME tags are supported, although if you use a graphic image as the link, the link but not the image is imported into Microsoft Excel. 

Anchors within a text string are placed on their own row so that a sentence that has an anchor in the middle ends up on three separate rows in Microsoft Excel.

Headers

Heading tags H1 through H6 are sized as shown in the following table.

Heading tag
Size of text

H1
22 points

H2
16 points

H3
12 points

H4
10 points

H5
8 points

H6
7 points

Lists

The DL/DT/DD tag is treated as a two-column list, and DD entries are indented to the second column.

The UL/LI tag is treated as a single-column, indented list.

The MENU/LI and DIR/LI tags are treated as single-column, unformatted lists.

The OL/LI tag is treated a single-column, numbered, and indented list.

Forms

No forms controls are supported.

Miscellaneous

The IMG, AREA, and MAP tags are not supported, but the ALT is supported.

The HR tag inserts a blank row surrounded by a border across the width of the page with the cells not merged. The SIZE of the border is 1, 2, or 3 pixels.

Tags Specific to Microsoft Internet Explorer 

FONT tags, such as COLOR, FACE, and SIZE are supported.

The MARQUEE tag is supported as centered text.

Tables

Many of the table tags mentioned in this section are in the sample file HTMLTbls.htm. Open this file to view the effect of these tags in Microsoft Excel and your browser.

TABLE Attributes

ALIGN is ignored as a table tag, but is used to position text within a cell with TR, TH, and TD attributes. 

WIDTH controls the width of the entire table relative to the screen, usually as a percentage of the screen.

BORDER sets the width of the border around the table.

FRAME specifies which sides of the table are bordered.

RULES controls cell borders within a range of cells.

COLGROUP specifies attributes that apply to groups of columns, though only the ALIGN attribute is supported.

COLSPAN controls cells spanning columns.

COLALIGN sets horizontal and vertical alignment of columns.

THEAD, TFOOT, and TBODY identify the main parts of a table.

CAPTION Tags

The CAPTION tag places text in the row above or below the table. CAPTION attributes, such as ALIGN, VALIGN, B, and I are supported:

ALIGN centers text by default, but left and right are also valid.
VALIGN places the text either above or below the table
B formats caption text as bold.
I italicizes caption text.
TR, TH, and TD Attributes

TR identifies a table row.

TH identifies a table header.

TD identifies an individual cell.

BGCOLOR identifies the background color of cells (TH and TD).

BORDERCOLOR is not supported.

Other Table Tags

The following tags are not supported: ID, LANG, DIR, CLASS, CLEAR, NOFLOW, CHAR, CHAROFF, COLS, CELLSPACING, and CELLPADDING.

HTML Extensions in Microsoft Excel 97

Microsoft Excel 97 supports several HTML table tag extensions that let you use some of best features in Microsoft Excel when creating HTML tables. These extensions can be built into Web pages, especially those that result from CGI scripts or other server programs, and return data uniquely formatted for use in Microsoft Excel 97 without impacting users who do not have Microsoft Excel. Browsers ignore these tag extensions when they display the HTML tables.

Formula

The FORMULA tag extension is an attribute of TH and TD tags. It places a function or formula in a specific cell. This allows the data to be imported into Microsoft Excel in spreadsheet form, which can easily be changed and automatically updated. The syntax of the formula is the Microsoft Excel function syntax, and any Microsoft Excel function or formula can be used. Use A1 style references that refer only to the current table. If you include a FORMULA tag for a table element that has no value assigned to it, the cell imported into Microsoft Excel is empty.

For example, to subtract expenses from sales to get a profit figure, you could create a table with the following HTML tags:

<TABLE>

<TR>

<TH>Sales

<TH>Expenses

<TH>Profit

<TR>

<TD>100

<TD>85

<TD FORMULA="A2-B2">15

</TABLE>

The preceding example produces a table that looks the same in both Microsoft Excel and your browser, though in Microsoft Excel the contents of the Profit cell is actually =A2-B2:

Sales
Expenses
Profit

100
85
15

By using formulas, you can change the data that comes from an HTML table, causing it to automatically recalculate results in Microsoft Excel that would be static in a browser.

When using Microsoft Excel built-in functions, be sure to insert an equal sign (=) in front of the function you want to use, as well as after the FORMULA tag, as shown in the following examples:

<TD FORMULA="=SUM(b2:b5)">1500

<TD FORMULA="=AVERAGE(d3:d10)">43.25

To use quotation marks within a function, put them in as “&quot;” or the browser will interpret the quote as the end of the formula attribute. For example, if you are using the concatenate function to join two strings, in Microsoft Excel the function would be:

=CONCATENATE("The ","Best")
but the formula in HTML would be:

<TD FORMULA="=CONCATENATE(&quot;The &quot;,&quot;Best&quot;)">The Best

Only English language formulas are supported. You cannot create formulas using the syntax or wording of any version of Microsoft Excel other than US English.

Styles

Figure 12: Custom number formats in the Format Cells dialog that can be used with the Style attribute.

Microsoft Excel imports numbers using the General format by default. However, you can format HTML numbers with other Microsoft Excel formats using the STYLE tag extension. The syntax for this in a table cell is:

<TD STYLE="vnd.ms-excel.numberformat:xxx">3/4

where xxx is the format you want to use. To see sample formats in Microsoft Excel, click Cells on the Format menu, click the Number tab, and then select Custom in the Category list. The sample formats are in the Type list, as shown in Figure 12. For more details about creating your own number formats, see Microsoft Excel online Help.

You can use the STYLE tag extension to solve potential problems with numbers and foreign language versions of Microsoft Excel. For example, if Microsoft Excel receives the numbers “+3/4” or “-3/4” it treats them correctly as numbers. However, if it receives “3/4” (no plus or minus sign), then it treats the number as a date and enters “4-Mar” in the cell because “3/4” is a valid date entry. To prevent this, use the STYLE tag as shown:

<TD STYLE="vnd.ms-excel.numberformat:?/?">3/4
As another example, European language versions of Microsoft Excel use a period separator as a date format, so in those languages Microsoft Excel changes “3.4” to a date, such as “3-Apr” in German. To prevent this from happening, use the STYLE tag extension as shown:

<TD STYLE="vnd.ms-excel.numberformat:#.#">3.4

To include certain characters in style formatting that also have special meaning in HTML you must use aliases for those characters. The aliases are:

ASCII character
HTML alias

;
[semicolon]

'
[squote]

"
[dquote]

For example, when using a multiple custom format in a cell style, Microsoft Excel displays it as:

# ??/??;-# ??/??;#

Because the semicolon would be interpreted in HTML incorrectly, substitute the alias [semicolon] as shown:

<TD STYLE="vnd.ms-excel.numberformat:# ??/??[semicolon]-# ??/??[semicolon]#">

In Microsoft Excel, the preceding example displays as a double-digit fraction for a positive number (# ??/??), a negative sign and a double-digit fraction for a negative number (-# ??/??), or nothing if it’s zero (#).
Filter (AutoFilter)

The FILTER tag extension causes Microsoft Excel to display AutoFilter drop-down buttons on the column headers. Selecting from the drop-down buttons allows the user to filter particular values from the complete table data. The table is displayed in its entirety in the browser.

FILTER tag extension can be used with TD, TH, TABLE, or TR tags. An example of the syntax is:

<TABLE>

<TR>

<TD FILTER=ALL>Store #

<TD FILTER=NONBLANKS>Date

<TD FILTER=ALL>Channel

<TD FILTER=ALL>Division

<TR><TD>Store 2<TD>1/8/95<TD>Wholesale<TD>Brass

<TR><TD>Store 6<TD>1/8/95<TD>Wholesale<TD>Electronic

<TR><TD>Store 5<TD>1/15/95<TD>Wholesale<TD>Brass

. . .

</TABLE>

The FILTER tag extension accepts the values ALL, BLANKS, NONBLANKS, or a text string that matches any of the values in the column.
Using any of these values determines what is displayed when the table is first opened in Microsoft Excel, but the user can change the display by using the AutoFilter drop-down buttons on the heading row. For example, in Figure 13, all stores with nonblank dates in all divisions are displayed.

Figure 13: AutoFilter list in Microsoft Excel (Autofilt.htm) showing an HTML table imported with AutoFilter drop-down buttons using the Filter tag extension.

Crosstab (PivotTables)

When creating an HTML table, you can use the CROSSTAB tag extension to generate a PivotTable when the data is brought into Microsoft Excel 97. This feature works only when opening the HTML document in Microsoft Excel, not when running a Web Query.

There are two tag extensions associated with the TABLE tag: CROSSTAB and CROSSTABGRAND. In addition, there are six tag extensions associated with the TH and TD tags: ROWFIELD, COLFIELD, DATAFIELD, PAGEFIELD, AGGREGATOR, and SUBTOTAL. The following discussion of these tag extensions refers to the sample file PivotTbl.htm:

<TABLE border CROSSTAB CROSSTABGRAND=ROWCOLUMN>

<TR>

<TH ROWFIELD>Store #

<TH>Date

<TH PAGEFIELD>Channel

<TH COLFIELD>Division

<TH>Product

<TH DATAFIELD AGGREGATOR="SUM">Units

<TH>Price

<TR><TD>Store 2<TD>1/1/96<TD>Wholesale<TD>Brass<TD>Trumpet<TD>7<TD>325

<TR><TD>Store 6<TD>1/8/96<TD>Wholesale<TD>Electronic<TD>Keyboard<TD>8<TD>795

<TR><TD>Store 5<TD>1/15/96<TD>Wholesale<TD>Brass<TD>Trumpet<TD>4<TD>400

. . .

</table>
The preceding example looks like the illustration in Figure 15 when the file is opened in Microsoft Excel.
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Figure 14: PivotTable of list in Microsoft Excel (PivotTbl.htm) showing the results of using PivotTable tag extensions. The original table data is hidden; only the resulting PivotTable displayed.

CROSSTAB

An attribute of the TABLE tag, CROSSTAB instructs Microsoft Excel to display the data as a PivotTable. If this attribute is used, then ROWFIELD, COLFIELD, DATAFIELD, PAGEFIELD, AGGREGATOR, and SUBTOTAL tags must appear in the first row of the table definition as attributes of TH or TD.

CROSSTABGRAND

This optional attribute CROSSTABGRAND works with CROSSTAB to designate if and how grand totals should be displayed. There are four possible values: NONE, ROW, COLUMN, or ROWCOLUMN (default). 

ROWFIELD, COLFIELD, DATAFIELD, and PAGEFIELD

The ROWFIELD, COLFIELD, DATAFIELD, and PAGEFIELD attributes indicate how to treat a column of data in the resulting PivotTable. These attributes must be in the first data row of the table. Any columns without these attributes (PRODUCT and PRICE in the preceding example) are not displayed in the PivotTable. Refer to Figure 14 for the results of using these attributes.

AGGREGATOR

The AGGREGATOR attribute lets you select an aggregator for the DATAFIELD, from the options listed in the following table.

Option
Description

SUM
Default for numeric data fields.

COUNT
Default for non-numeric data.

AVERAGE
Average of the numbers in the data field.

MAX
Maximum number in the data field.

MIN
Minimum number in the data field.

PRODUCT
Product of the numbers in the data field.

COUNTNUMS
Number of rows with data.

STDDEV
Estimate of the standard deviation of a population, where the underlying data is the sample.

STDDEVP
Standard deviation of the population, where the underlying data is the entire population.

VAR
Estimate of the variance of the population, where the underlying data is the sample.

VARP
Variance of a population of data, where the underlying data is the entire population.

To display multiple aggregators for a single data field, use a comma-separated list as shown:

<TH DATAFIELD AGGREGATOR="SUM,AVERAGE">Sales
SUBTOTAL

The SUBTOTAL attribute controls which row, column, and page field values are subtotaled. It applies to TH and TD tags with ROWFIELD, COLFIELD, and PAGEFIELD attributes. When SUBTOTAL is specified for a row, subtotal values are inserted in the PivotTable for each grouping of the field specified.

The options available for SUBTOTAL are the same as those for the AGGREGATOR attribute. See the table in the previous section for a list of them. 

To display multiple subtotal values for a single data field, use a comma-separated list.

Appendix A: Files Included With This Kit

The following table lists files included with the Microsoft Excel Connectivity Kit, and how to use them.

File
Description
Use this application

AutoFilt.htm
HTML file showing FILTER tag extension for Microsoft Excel.
Microsoft Excel to view; Microsoft Internet Explorer to compare HTML tag handling; Notepad to view or edit tags.



Formulas.htm
HTML file showing FORMULAS tag extension for Microsoft Excel.
Microsoft Excel to view; Microsoft Internet Explorer to compare HTML tag handling; Notepad to view or edit tags.



HTMLTbls.htm
HTML file showing several standard table tags.
Microsoft Excel to view; Microsoft Internet Explorer to compare HTML tag handling; Notepad to view or edit tags.



HTMLTags.htm
HTML file showing several standard tags.
Microsoft Excel to view; Microsoft Internet Explorer to compare HTML tag handling; Notepad to view or edit tags.



M_Quotes.iqy
Sample POST Web Query file.
Notepad to view IQY structure.



MResults.htm
HTML file resulting from query to StockPst.htm form; shows what can be produced by such a query—view in both a Web browser and Microsoft Excel to compare results.
Microsoft Excel to view results of query; Microsoft Internet Explorer to compare HTML tag handling.



Pcquote.iqy
Query file using PC Quote server.
Microsoft Excel to run; Notepad to view or edit. Requires Internet connection.



Pcquote.xls
Microsoft Excel worksheet using Pcquote.iqy.
Microsoft Excel to run and edit. Requires Internet connection.



PivotTbl.htm
HTML file showing Microsoft Excel PivotTable extensions.
Microsoft Excel to view; Microsoft Internet Explorer to compare HTML tag handling; Notepad to view or edit tags.



Readme.txt
Text file containing last minute changes or additions to this kit.
Notepad to view.



S_Quote.iqy
Sample GET Web Query file.
Notepad to view IQY structure.



SResults.htm
HTML file resulting from query to StockGet.htm form; shows what can be produced by such a query—view in both a Web browser and Microsoft Excel to compare results.
Microsoft Excel to view results of query; Microsoft Internet Explorer to compare HTML tag handling.



StockGet.htm
HTML GET form file for a single stock quote; demonstrates key form fields used in Web Query in Microsoft Excel.
Microsoft Internet Explorer to view; Notepad to view or edit tags.



StockPst.htm
HTML Post form file for multiple stock quotes; demonstrates key form fields used in Web Query in Microsoft Excel.
Microsoft Internet Explorer to view; Notepad to view or edit tags.



WebCnKit.doc
This document.
Word 97 to open.



Webcnkit.exe
Self-extracting zip file of all files in this appendix.
Run file to extract sample files and Web Connectivity Kit.

Use this to create a link to another Microsoft Excel file or a Web page on the Internet or an Iintranet.





Enter the destination for your query here or select New worksheet.





Enter any values here for the query parameters.








Select one of these options for the method of receiving query data relative to existing worksheet content.





Select this check box to only import HTML <table> data with the query.*











Click here to interactively select a cell or range.





Select this option to use values from the cell or specified range for the parameter.





Select this option to use the entered text as the value for the parameter in this query and future refreshes.





Prompt string that is displayed when the query is run.





Query name





Entry field for parameter value





Select this check box to update the query results each time the workbook is opened.





Select this check box to update the query results in the background when you click Refresh Data (Data menu).





Select this check box to retain the query defintition with the worksheet.





Prompt text from the IQY file





Select this option to retain the value for future use in the worksheet. Enabling this option does not change the IQY file.





Click here to interactively select a cell or range from the worksheet to use as the parameter values.





Select this check box to make column widths match the query results.














The custom formats in the Type list are examples of formatting that can be used with the Style attribute extension to pre-format numbers and text coming in to Microsoft Excel from HTML.








PAGEFIELD





COLFIELD





ROWFIELD





DATAFIELD





The number of parameters and the text above the entry field are determined by the contents of the IQY file. For information about this file, see “Creating a Web Query” later in this document.
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